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Getting Started
Chapter Objectives
After completing this chapter you should:
1. understand how the X, Y, Z coordinate
system is used to define the location of
drawing elements in digital format in a CAD
drawing file;
2. understand why you should create drawings
full size in the actual units with CAD;
3. be able to start AutoCAD to begin drawing;
4. recognize the areas of the AutoCAD Drawing
Editor and know the function of each;
5. be able to use the many methods of entering
commands;
6. be able to turn on and off the Snap, Grid,
Ortho, Polar, and Dynamic Input drawing
aids;
7. know how to customize the AutoCAD for
Windows screen to your preferences.
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CONCEPTS

FIGURE 1-1

Coordinate Systems
Any location in a drawing, such
as the endpoint of a line, can be
described in X, Y, and Z coordinate
values (Cartesian coordinates). If a
line is drawn on a sheet of paper,
for example, its endpoints can be
charted by giving the distance over
and up from the lower-left corner of
the sheet (Fig. 1-1).
These distances, or values, can be
expressed as X and Y coordinates;
X is the horizontal distance from
the lower-left corner (origin) and
Y is the vertical distance from that
origin. In a three-dimensional coordinate system, the third dimension,
Z, is measured from the origin in a
direction perpendicular to the plane
defined by X and Y.

FIGURE 1-2

Two-dimensional (2D) and threedimensional (3D) CAD systems use
coordinate values to define the location of drawing elements such as
lines and circles (called objects
in AutoCAD).
In a 2D drawing, a line is defined
by the X and Y coordinate values
for its two endpoints (Fig. 1-2).
In a 3D drawing, a line can be
created and defined by specifying
X, Y, and Z coordinate values
(Fig. 1-3). Coordinate values are
always expressed by the X value
first separated by a comma, then Y,
then Z.
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FIGURE 1-3
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The CAD Database

FIGURE 1-4

A CAD (Computer-Aided Design) file, which is the electronically stored version of the
drawing, keeps data in binary digital form. These digits describe coordinate values for
all of the endpoints, center points, radii, vertices, etc. for all the objects composing the
drawing, along with another code that describes the kinds of objects (line, circle, arc,
ellipse, etc.). Figure 1-4 shows part of an AutoCAD DXF (Drawing Interchange Format)
file giving numeric data defining lines and other objects. Knowing that a CAD system
stores drawings by keeping coordinate data helps you understand the input that is
required to create objects and how to translate the meaning of prompts on the screen.
FIGURE 1-5

Angles in AutoCAD
Angles in AutoCAD are measured in
a counterclockwise direction. Angle 0
is positioned in a positive X direction,
that is, horizontally from left to right.
Therefore, 90 degrees is in a positive Y
direction, or straight up; 180 degrees
is in a negative X direction, or to the
left; and 270 degrees is in a negative Y
direction, or straight down (Fig. 1-5).
The position and direction of measuring angles in AutoCAD can be
changed; however, the defaults listed
here are used in most cases.

Draw True Size
When creating a drawing
with pencil and paper tools,
you must first determine a
scale to use so the drawing
will be proportional to the
actual object and will fit on
the sheet (Fig. 1-6). However,
when creating a drawing on
a CAD system, there is no
fixed size drawing area. The
number of drawing units that
appear on the screen is variable and is assigned to fit the
application.

FIGURE 1-6
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Create CAD drawings true size using real-world units so the values will be useful for analysis and measurements. The user specifies what units are to be used (architectural, engineering, etc.) and then specifies what size drawing area is needed (in X and Y values) to draw the necessary geometry (Fig. 1-7).
FIGURE 1-7

Whatever the specified size of the drawing area, it can be displayed on the screen in its entirety (Fig. 1-7)
or as only a portion of the drawing area (Fig. 1-8).
FIGURE 1-8
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Plot to Scale

FIGURE 1-9

As long as a drawing exists as a CAD file or is visible on the screen, it is
considered a virtual, full-sized object. Only when the CAD drawing is
transferred to paper by a plotter or printer is it converted (usually reduced)
to a size that will fit on a sheet. A CAD drawing can be automatically scaled
to fit on the sheet regardless of sheet size; however, this action results in a
plotted drawing that is not to a typical scale (not to a whole number proportion of the real object). Usually it is desirable to plot a drawing so that the
resulting drawing is a proportion of the actual object size. It is preferred to
use whole numbers for the scale proportions, for example 4 drawing units
equals 1 unit on the paper and not proportions such as 3.5 drawing units
equals 1 unit on the paper. The scale to enter as the plot scale (Fig. 1-9) is
simply the proportion of the plotted drawing size to the actual object.

STARTING AutoCAD

FIGURE 1-10

Assuming that AutoCAD has been installed
and configured properly for your system,
you are ready to begin using AutoCAD.
To start AutoCAD 2023, locate the
“AutoCAD 2023” shortcut icon on the
desktop (Fig. 1-10). Double-clicking on the
icon launches AutoCAD 2023.
If you cannot locate the AutoCAD 2023
shortcut icon on the desktop, select the “Windows” button and
search for “AutoCAD 2023” in the Programs list (Fig. 1-11).

FIGURE 1-11
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THE AutoCAD DRAWING EDITOR
When you start AutoCAD, you see the Start Screen (Figure 1-12) that allows you to launch the Drawing
Editor or other resources. The Drawing Editor is composed of a central drawing area, called the “graphics”
area, and an array of toolbars, menus, a command line, and other elements, depending on the workspace and other settings that you can change.

2023

Beginning a Drawing

FIGURE 1-12

Start tab
When you open an AutoCAD
session, the Start tab appears
for you to choose what
drawing you want to work
with (Fig. 1-12).
Once you choose to start a
new drawing (Fig. 1-12 inset)
or work with an existing
drawing, your screen changes
to the Drawing Editor (see
Figure 1-13).
NOTE: For clarity, this book
displays a white background
for the Drawing Editor,
whereas the default color for
the background is black. It also
uses the light color scheme for
the ribbon and other tools.
FIGURE 1-13

NOTE: AutoCAD adjusts
its display to the size of its
window. This can result in
minimized panels (such as
Utilities and Groups in Figure
1-13) and hidden tool captions
in other panels.
Your AutoCAD environment
can be customized, as discussed later in the chapter. So,
don’t worry if what you see on
the screen does not precisely
match the illustrations in every
detail.

Ribbon

Graphics Area
Palette
Crosshairs
Cursor
Command Line
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In the Start tab, you can create a new drawing by selecting the New option. The new drawing is based
on the most recently used template. You could also select from other templates using the drop-down
list using the small arrow at the right of the New selection. Normally a template drawing contains no
geometry (lines, arcs, circles, etc.) but has specific settings based on what and how you intend to draw.
For example, if you intend to use inch units, use the ACAD.DWT template drawing; if you intend to use
metric units, use the ACADISO.DWT.
Alternately, you can select Open... to locate and open an existing drawing, Open a Sheet Set or Explore
Sample Drawings that are installed when you install AutoCAD. You can also select from Recent Documents
(drawings) shown in the list in the center of the Create screen.
The center section of the opening screen (Start tab) lists the Recent Documents that were opened (Fig. 1-12,
center). Here you can select from a list rather than browsing for files using the Open Files option on the
left. The Recent Documents list can be changed to large thumbnail images (as shown in Figure 1-12), or to
details with no image (file name, date, time).

Drafting & Annotation Workspace
The workspace that typically appears in the Drawing Editor when you begin drawing for the first time
is the Drafting & Annotation workspace. This workspace offers functions for creating 2-dimensional
(2D) drawings. Two other workspaces are available for working with 3-dimensional (3D) drawings (see
Chapter 33). The basic organization of all workspaces is the same—changing the workspace simply
provides different command options from the “Ribbon” near the top of the screen.
Ribbon
The Ribbon is located along the top of the screen (Fig. 1-13) and consists of tabs, panels and tools. Panels
are the groups of related tools (commands) between the vertical separators with titles such as Draw,
Modify, and Layers. The panels that appear are based on the active tab that is selected (above the panels)
such as Home, Insert, Annotate, and so on. For example, selecting the Home tab produces the Draw, Modify,
Annotation, Layers, Block and other panels.
Graphics Area
The large central area of the screen is the Graphics Area. It displays the lines, circles, and other objects
you create to make up the drawing. The cursor is the intersection of the crosshairs cursor (crossing vertical and horizontal lines that follow the mouse movements). The default size of the graphics area for
English settings is 12 units (X or horizontal) by 9 units (Y or vertical). This usable drawing area (12 x 9)
is called the drawing Limits and can be changed to any size to fit the application. To see the display of
coordinates in the AutoCAD screen, turn on the Coordinate Display on the Status Bar. See “Status Bar,
Coordinates,” in the next section.
Palettes
When you activate the Drafting & Annotation workspace, one or more palettes can be activated as needed
on your screen. Figure 1-13 displays the Properties palette. Each palette serves a particular function as
explained in later chapters. You can close the palettes by clicking on the “X” in the upper corner of the
palette.
Command Line
The Command line consists of the one to three text lines (by default) at the bottom of the screen (see
Fig. 1-13). Any command that is entered as well as the prompts that AutoCAD issues normally appear
here. The Command line gives the current state of drawing activity. It is very important to keep aware
of the Command line as you draw while you are learning AutoCAD. You should develop the habit of
glancing at the Command line while you work in AutoCAD. The Command line can be set to display
any number of lines and it can be moved to another location (see “Customizing the AutoCAD Screen”
later in this chapter).
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Application Menu and Quick Access Toolbar
All workspaces provide the Application Menu and Quick Access toolbar (Fig. 1-14). The Application
Menu is accessed by selecting the large, red letter “A” in the upper-left corner of the AutoCAD window.
Selecting this button produces a list of options that allow you to manage drawing files. For example, you
can create new drawings, open existing drawings, or save, export, and print drawings. You can also use
the search box above the list to search for commands. The Quick Access toolbar, just to the right of the
letter “A”, contains frequently used commands such as Qnew, Open, Save, Undo, and Plot.
FIGURE 1-14

Quick Access
Toolbar

Current
Workspace

Application
Menu

FIGURE 1-15

Menu Bar
A Menu Bar is available that provides a series of pull-down menus
along the top of the Drawing
Editor just above the Ribbon. The
Menu Bar is useful for learning
AutoCAD because the command
names are listed beside each icon.
If you are looking for a particular
command, searching the pulldown menus is faster and easier
than searching the Ribbon. You
can enable the Menu Bar by selecting the Show Menu Bar option
from the Quick Access toolbar
drop-down arrow (Fig. 1-15).

Click to
expand
options

Check to show
Workspace

Check to show
Menu bar
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Selecting any of the words in the Menu Bar activates, or pulls down, the respective menu (Fig. 1-16).
Selecting a word appearing with an arrow activates a cascading menu with other options. Selecting a word
with an ellipsis (. . .) activates a dialog box (see “Dialog Boxes and Palettes”). Words in the pull-down
menus are not necessarily the same as the formal command names used when typing commands. Menus
can be canceled by pressing Escape or picking in the graphics area.
FIGURE 1-16

Dialog Boxes and Palettes
Dialog boxes and Palettes
provide interfaces for controlling complex commands or a
group of related commands.
Depending on the command,
dialog boxes and palettes allow
you to select among multiple
options and sometimes give a
preview of the effect of selections. The Layer Properties
Manager palette
(Fig. 1-17) gives complete
control of layer colors, linetypes, and visibility.

FIGURE 1-17

Dialog boxes and palettes can be invoked by typing a command, selecting an icon button, or PICKing
from the menus. For example, typing Layer, PICKing the Layer Properties Manager button, or selecting
Layer from the Format pull-down menu causes the Layer Properties Manager to appear. Palettes and dialog
boxes can be resized to display more or less information.
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The basic elements of a dialog box are:
Button		
Resembles a push button and triggers some type of action.
Edit box
Allows typing or editing of a single line of text.
Image tile
A button that displays a graphical image.
List box
A list of text strings from which one or more can be selected.
Drop-down list
A text string that drops down to display a list of selections.
Radio button
A group of buttons, only one of which can be turned on at a time.
Checkbox
A checkbox for turning a feature on or off (displays a check mark when on).
Shortcut Menus
AutoCAD makes use of shortcut menus that are activated by
pressing the right mouse button (sometimes called right-click
menus). Shortcut menus give quick access to command options.
There are many shortcut menus to list since they are based on the
active command or dialog box. The menus fall into five basic
categories listed here.

FIGURE 1-18

Default Menu
The default menu appears when you right-click in the drawing
area and no command is in progress. Using this menu, you can
repeat the last command, select from recent input (like using
the up and down arrows), use the Windows Cut, Copy, Paste
functions, and select from other viewing and utility commands
(Fig. 1-18).

Edit-Mode Menu
This menu appears when you right-click when objects have been
selected but no command is in progress. Note that several of
AutoCAD’s Modify commands are available on the menu such as
Erase, Move, Copy, Scale, and Rotate (Fig. 1-19).
NOTE: Edit mode shortcut menus do not appear if the PICKFIRST
system variable is set to 0 (see “PICKFIRST” in Chapter 20).

FIGURE 1-19
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Command-Mode Menu
These menus appear when you right-click when a command is in
progress. This menu changes since the options are specific to the command
(Fig. 1-20).

FIGURE 1-20

Dialog-Mode Menu
When the pointer is in a dialog box or tab and you right-click, this menu
appears. The options on this menu can change based on the current
dialog box (Fig. 1-21).

FIGURE 1-21

Other Menus
There are other menus that can be invoked. For example, a menu appears if you right-click in the
Command line area.
Because there are so many shortcut menus, don’t be too concerned about learning these until you have
had some experience. The best advice at this time is just remember to experiment by right-clicking often
to display the possible options.

Command Entry Using the Keyboard
Although commands are accessible using toolbars, the dashboard, pull-down menus, and shortcut
menus, you can enter the command using the keyboard. As you type the letters, they appear on the
Command line (near the bottom of the screen) or in the Dynamic Input box near the cursor (see “Drawing
Aids,” “Dynamic Input”). Using the keyboard to type in commands offers several features:
Command name
Command alias
Accelerator keys
Up and down arrows
Tab key

Type in the full command name.
Type the one- or two-letter shortcut for the command (see App. A).
Type a Ctrl key plus another key to invoke the command (see App. B).
Use the up and down arrows to cycle through the most recent input.
Type in a few letters and press the Tab key to “AutoComplete” the command.
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Accelerator Keys (Control Key Sequences)
Several control key sequences (holding down the Ctrl key or Alt key and pressing another key simultaneously) invoke regular AutoCAD commands or produce special functions (see App. B).

Special Key Functions
Esc		
The Esc (escape) key cancels a command, menu, or dialog box or interrupts some
		processes.
Space bar

In AutoCAD, the space bar performs the same action as the Enter key. Only when you
are entering text into a drawing does the space bar create a space.

Enter		

If Enter or the space bar is pressed when no command is in use (the open Command:
prompt is visible), the last command used is invoked again.

Mouse Buttons
Depending on the type of mouse used for cursor control, a different number of buttons is available. In
any case, the buttons normally perform the following tasks:
left button

PICK

Used to select commands or pick locations on the screen.

right button
Enter or shortcut menu
		
		

Depending on the status of the drawing or command, this
button either performs the same function as the Enter key
or produces a shortcut menu.

wheel
Pan
		
Zoom

If you press and drag, you can pan the drawing about on
the screen.
If you turn the wheel, you can zoom in and out centered
on the location of the cursor.

COMMAND ENTRY
Methods for Entering Commands
There are many possible methods for entering commands in AutoCAD depending on your system configuration. Generally, most of the methods can be used to invoke a particular commonly used command
or dialog box.
1. Keyboard

Type the command name, command alias, or accelerator keys at
the keyboard.

2. Menu Bar

Select the command or dialog box from a pull-down menu.

3. Tools (icon buttons)

Select the command or dialog box by PICKing a tool (icon button)
from a toolbar, palette, or Ribbon.

4. Shortcut menus

Select the command from the right-click shortcut menu.
Right-clicking produces a shortcut menu depending on whether
a command is active, objects are selected, or the pointer is in a
dialog box.
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Understanding the “Command Tables” in this Book
Command tables, like the one below, are used throughout this book to show the possible methods for
entering a particular command. The table shows the icon used in the toolbars, the palettes, and the
Ribbon, indicates the tab and panel on the Ribbon for locating the icon, gives the selections to make for
the pull-down menu, gives the correct spelling for entering commands and command aliases at the keyboard, and gives the shortcut menu and option. This example uses the Line command.

Line
Ribbon
Home
Draw
Line

Menu Bar
Draw
Line

Command
(Type)

Alias
(Type)

Shortcut

Line

L

...

Command Entry Methods Practice
Start AutoCAD. Use the ACAD.DWT template. Invoke the Line command using each of the command
entry methods as follows.
1. Type the command
Steps

Command Prompt

1.

Perform Action

Comments

press Escape if another command is in use

2.

Command:

type Line and press Enter

3.

LINE Specify first point:

PICK any point

a “rubberband” line appears

4.

Specify next point or
[Undo]:

PICK any point

another “rubberband” line
appears

5.

Specify next point or
[Undo]:

press Enter

to complete command

2. Type the command alias
Steps

Command Prompt

1.

Perform Action

Comments

press Escape if another command is in use

2.

Command:

type L and press Enter

3.

LINE Specify first point:

PICK any point

a “rubberband” line appears

4.

Specify next point or
[Undo]:

PICK any point

another “rubberband” line
appears

5.

Specify next point or
[Undo]:

press Enter

to complete command
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3. Menu Bar
Steps

4.

Comments

Command:

select the Draw menu from
the menu bar

2.

Command:

select Line

menu disappears

3.

LINE Specify first point:

PICK any point

a “rubberband” line appears

4.

Specify next point or
[Undo]:

PICK any point

another “rubberband” line
appears

5.

Specify next point or
[Undo]:

press Enter

to complete command

Ribbon (Drafting & Annotation workspace)
Command Prompt

Perform Action

Comments

1.

Command:

select the Line icon from the
Draw panel on the Home tab

the Line tool is the first icon in
the Draw panel

2.

LINE Specify first point:

PICK any point

a “rubberband” line appears

3.

Specify next point or
[Undo]:

PICK any point

another “rubberband” line
appears

4.

Specify next point or
[Undo]:

press Enter

to complete command

Shortcut menu
Steps

6.

Perform Action

1.

Steps

5.

Command Prompt

Command Prompt

Perform Action

Comments

1.

Command:

right-click in the drawing
area and select Repeat LINE
from menu

Repeat LINE should be first in
the list

2.

LINE Specify first point:

PICK any point

a “rubberband” line appears

3.

Specify next point or
[Undo]:

PICK any point

another “rubberband” line
appears

4.

Specify next point or
[Undo]:

press Enter

to complete command

Click an Option from the Command Prompt
1.
Select the Circle icon from the Draw panel on the Home tab.
2.
PICK on the 2P option from the command prompt.
3.
press Esc to cancel the command.

Click on an
option

When you are finished practicing, use the Application Menu or the File menu and select Exit to exit
AutoCAD. You do not have to “Save Changes.”
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DRAWING AIDS
This section explains several features that appear near the bottom of the Drawing Editor including the
Status Bar drawing aids, Model and Layout tabs, and the Text window.

Status Bar
The Status Bar appears at the bottom of the AutoCAD window and contains a set of icons that allow you
to turn on or off drawing aids such as Grid, Snap, Dynamic Input, and Polar Tracking (Fig. 1-22, bottom).
Gray icons indicate the feature is off and blue icons indicate the feature is on. You can turn some features
on or off using a function key as an alternative to clicking the icons, such as F7 to turn Grid on or off (see
“Function Keys” later in this chapter).
FIGURE 1-22

Status Bar
Toggles

Status Bar

Coordinates Display

Status Bar
Customization
Button

You can determine which drawing aid icons appear on the Status Bar by using the Customization button
(Fig. 1-22, bottom-right corner). This button produces a list of drawing aids that you check or uncheck
(Fig. 1-22, right). Therefore, checking or unchecking a word in the list determines if that icon appears on
the Status Bar.
Coordinates
The Coordinate display (sometimes referred to as “Coords”) displays the position of the cursor (crosshairs) in X, Y, and Z coordinates. The coordinate display is located at the left end of the Status Bar (see
Fig. 1-22). This can be very helpful when you draw because the current coordinate position of the cursor
is displayed as the cursor moves, sometimes called “cursor tracking.” It is recommended to turn the
coordinates on while you begin learning AutoCAD. You can click on the numbers to turn this feature
on or off. The default setting (in the acad.dwt template) displays decimal format with four places to
the right of the decimal. Although this format can be changed, AutoCAD always records 14 significant
places for every coordinate!
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When the coordinate display is turned on, there are four possible formats: Absolute, Relative, Geographic,
and Specific. Access these options by right-clicking on the coordinate display.
Absolute

This option tracks the current cursor location in absolute coordinates (relative to
0,0,0).

Relative

This option tracks the current cursor location in coordinates relative to the last
point established but in a polar format (distance and angle). This option appears
only if a point has been established, such as when the first point of a Line has
been designated.

Geographic

Use this option when you have set a geographic location in the drawing
(Geographiclocation command).

Specific

This option displays the coordinates only when you click to select a point rather
than continuously tracking the current location of the cursor.

MODEL/PAPER (Model Space or Paper Space)
Next to the Coordinate display the word PAPER or MODEL appears by default. There are two spaces in
AutoCAD—Model Space, where you draw, and Paper Space, where you prepare to print a drawing.
See Chapter 13 for an introduction to Paper Space and Model Space.
Grid (Grid Mode, F7)
This drawing aid can be used to give a visual reference of units of length. The Grid default value for
English settings (acad.dwt template) is .5 units. The Grid command or Drawing Aids dialog box
allows you to change the interval to any value. The Grid is not part of the geometry and is not plotted.
Figure 1-23 displays a Grid of .5. Snap and Grid are independent functions—they can be turned on or
off independently.
FIGURE 1-23
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Snap Mode (F9)
Snap has two modes in AutoCAD: Grid Snap and Polar Snap. Only one of the two modes can be active
at one time. Grid Snap is a function that forces the cursor to “snap” to regular intervals (.5 units is the
default setting), which aids in creating geometry accurate to interval lengths. You can use the Snap
command or the Drafting Settings dialog box to specify any value for the Snap increment. Figure 1-23 displays a Snap setting of .5 (note the values in the coordinate display).
The other mode of Snap is Polar Snap. Polar Snap forces the cursor to snap to regular intervals along
angular lines. Polar Snap is functional only when Polar Tracking is also toggled on since it works in
conjunction with Polar Tracking. The Polar Snap interval uses the Grid Snap setting by default but can
be changed to any value using the Snap command or the Drafting Settings dialog box. Polar Snap is
discussed in detail in Chapter 3.
Since you can have only one Snap mode on at a time (Grid Snap or Polar Snap), you can select which of
the two is on by right-clicking on the icon on the Status Bar. You can also access the Drafting Settings
dialog box by selecting Snap Settings… from the pop-up menu (see Figure 1-23).
Infer Constraints
Enabling Infer Constraints mode automatically applies constraints between the object you are creating or
editing and the object or points associated with object snaps. For most drawings, turn this feature off.
Dynamic Input (F12)
Dynamic Input is a feature that helps you visualize and specify coordinate values and angular values
when drawing lines, arcs, circles, etc. Dynamic Input may display absolute Cartesian coordinates (X and
Y values) or relative polar coordinates (distance and angle) depending on the current command prompt
and the settings you prefer (Fig. 1-24).
FIGURE 1-24

Dynamic
Input
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Dynamic Input is explained further in Chapter 3. You can toggle Dynamic Input on or off by using the
icon or the F12 key. You can change the format of the display during input by right-clicking on the icon
and selecting Dynamic Input Settings from the menu. For example, you can set Dynamic Input to display
a “tool tip” that gives the current coordinate location of the cursor (cursor tracking mode) when no commands are in use.
Ortho Mode (F8)
If Ortho Mode is on, lines are forced to an orthogonal alignment (horizontal or vertical) when drawing.
Ortho is often helpful since so many drawings are composed mainly of horizontal and vertical lines.
Polar Tracking (F10)
Polar Tracking makes it easy to draw lines at regular angular increments, such as 30, 45, or 90 degrees.
The F10 key or the icon button toggles Polar Tracking on or off. When Polar Tracking is on, a polar tracking vector (a faint dotted line) appears when the “rubber band” line approaches the desired angular
increment as shown in Figure 1-25. By default, Polar Tracking is set to 90 degrees, but can be set to any
angular increment by right-clicking on the icon and selecting an angle option (bottom-right, Figure 1-25).
FIGURE 1-25
Polar
Tracking

Isometric Drafting
This drawing aid helps you draw an isometric drawing by setting the Snap Mode and the Grid Mode to a
30-degree orientation. See Chapter 25, Pictorial Drawings, for more information.
Object Snap Tracking
The Object Snap Tracking feature is discussed in Chapter 7, Object Snap and Object Snap Tracking.
2D Object Snap
Object Snap allows you to easily “snap,” or attach, to object endpoints, midpoints, centers, etc. The Object
Snap feature is discussed in detail in Chapter 7.
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LineWeight
Use this aid to display line thicknesses that may be applied to objects. See Chapter 11.
Transparency
Imported images can have a transparency quality applied. Use this icon to display or not display transparency. See Chapter 11 for a full explanation.
Selection Cycling
Chapter 4 explains how to use Selection Cycling.
3D Object Snap
You can snap to vertices, midpoints, faces, etc. of 3D objects. This icon is used to turn this feature on or
off.
Dynamic UCS
You can use Dynamic User Coordinate Systems when creating or editing 3D objects. See Chapter 35 for
more information.
Selection Filtering
Discussed in Chapter 20, Advanced Selection Sets, this feature assists when selecting objects for editing.
Gizmo
A Gizmo can be used to create and edit 3D objects. This feature is discussed with the solid modeling
information.
Annotation Visibility
Dimensions and text objects can be made to change size automatically. This option allows you to see
changes made by scale changes to the current viewport.
AutoScale
This feature toggles the automatic scaling of annotation objects on or off.
Annotation Scale
This pop-up list of standard scales allows you to set the desired scale for annotation in the current viewport.
Workspace Switching
Use this list to select from the three workspaces (Drafting & Annotation, 3D Basics, and 3D Modeling) as
well as control the customization of your workspaces.
Annotation Monitor
Dimensions are associated (attached) to objects. You can use the Annotation Monitor to flag dimensions
that lose associativity when objects are moved or updated.
Units
When turned on, the current units for the drawing are displayed such as decimal or feet and inches.
Quick Properties
When you select objects to edit, a Quick Properties panel (giving properties of the selected objects) may
appear based on your setting with this icon. See Chapter 16.
Lock UI
Use Lock UI to “lock” in place user interface elements such as windows, palettes, and toolbars from being
accidentally or otherwise moved or changed.
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Isolate Objects
This icon provides a quick method for using the Hideobjects, Isolateobjects, and Unisolateobjects commands.
See Chapter 20 for more information on these features.
Graphics Performance
This icon provides access to the Graphics Performance dialog box where you can tune the performance of
your graphics display.
Clean Screen
Clean Screen removes the Ribbon so you have more screen area to draw. See the “Customizing the
AutoCAD Screen” section next in this chapter.

Function Keys
Several function keys are usable with AutoCAD. They offer a quick method of turning on or off (toggling) drawing aids and other features.
F1

Help

F2

Text window

F3

Object Snap

F4
F5

3D Object Snap
Isoplane

F6
F7
F8
F9
F10
F11
F12

Dynamic UCS
Grid
Ortho
Snap
Polar Tracking
Object Snap Tracking
Dynamic Input

AutoCAD Text Window

Opens a help window providing written explanations on commands
and variables.
Activates the text window showing the previous command line activity
(command history).
Turns Running Object Snaps on or off. If no Running Object Snaps are set,
F3 produces the Object Snap Settings dialog box (discussed in Chapter 7).
Turns 3D Object Snap on or off.
When using an Isometric style Snap and Grid setting, toggles the cursor
(with Ortho on) to draw on one of three isometric planes.
Turns Dynamic UCS on or off for 3D modeling (see Chapters 35 and 36).
Turns the Grid on or off.
Turns Ortho on or off.
Turns Snap on or off.
Turns Polar Tracking on or off.
Turns Object Snap Tracking on or off.
Turns Dynamic Input on or off.
FIGURE 1-26

Pressing the F2 key activates the
Text Window, sometimes called the
Command History (Fig. 1-26). Here
you can see the text activity that
occurred at the Command line—
kind of an “expanded” Command
line. Press F2 again to close the text
window. The right-click menu in
this text window provides several
options. If you highlight text in
the window, you can then Paste to
Command line, Copy it to another
program such as a word processor,
Copy History (entire command history) to another program, or Paste text into the window. The Options
choice invokes the Options dialog box (discussed later).
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Several options in the rightclick menu of the text window
allow you to customize how the
Command line operates. For
example, selecting Input Settings
provides options for how AutoCAD
responds as you type words at the
Command line. Here you can toggle
AutoComplete and AutoCorrect as
well as what content in the drawing
is searched when you begin typing.

FIGURE 1-27

Selecting Input Search Options from
the text window right-click menu
invokes the dialog box shown in
Figure 1-27. This box provides complete control of how AutoCAD completes, corrects, and searches as you
type words into the Command line.
Selecting the Transparency option produces a window that controls the percentage of transparency you
prefer for the Command line. Use the Lines of Prompt History to specify the maximum number of text
lines that appear when the Command line automatically expands as you work. The setting is saved in
the CLIPROMPTLINES system variable and is set to 3 by default.

Model Space and Layouts
Model Space
When you begin a drawing, model space is the current drawing space. This area is also known as the
Model tab (Fig. 1-28, lower-left). In this area you should create the geometry representing the subject of
your drawing, such as a floor plan, a mechanical part, or an electrical schematic. Dimensions are usually
created and attached to your objects in model space.
FIGURE 1-28
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Layouts
When you are finished
with your drawing, you
can print it directly from
model space or switch
to a layout (Fig. 1-29).
Layouts, sometimes
known as paper space,
represent sheets of paper
that you print on.

FIGURE 1-29

You must use several
commands to set up the
layout to display the
geometry and set all the
printing options such as
scale, paper size, device,
and so on. Printing and
layouts are discussed in
detail in Chapters 13, 14,
and 32.

Paperspace
icon

CUSTOMIZING THE AutoCAD SCREEN
Toolbars
Many toolbars are available, each with a group
of related commands for
specialized functions.
For example, when you
are ready to dimension a
drawing, you can activate
the Dimension toolbar for
efficiency.
To activate toolbars, select
Toolbars from the Tools
pull-down menu. Selecting
any toolbar name makes
that toolbar appear on
the screen (Fig. 1-30). If a
toolbar is already visible on
the screen, you can rightclick on it to produce a list
of all available toolbars.

FIGURE 1-30
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You can also type the -Toolbar command (don’t forget the hyphen) at the Command line. Next, type the
name of the toolbar you want to appear, such as Draw or Dimension. Use the Show option to make the
toolbar appear on the screen. (The Toolbar command [without the hyphen] produces the Customize User
Interface dialog box that is used for customizing the Ribbon, menus, toolbars, palettes, and workspaces.)
By default, most toolbars that are newly activated are floatFIGURE 1-31
ing (see Fig. 1-30). A floating toolbar can be easily moved to
any location on the screen if it obstructs an important area of a
drawing. Placing the pointer in the title background allows you
to move the toolbar by holding down the left button and dragging it to a new location (Fig. 1-31). Floating toolbars can also
be resized by placing the pointer on the narrow border until a
two-way arrow appears, then dragging left, right, up, or down.
A floating toolbar can be docked
against any border (right, left,
top, bottom) by dragging it to the
desired location (Fig. 1-32). Several
toolbars can be stacked in a docked
position. By the same method,
docked toolbars can be dragged
back onto the graphics area.

FIGURE 1-32

Toolbars can be removed from the
screen by clicking once on the “X”
symbol in the upper right of a floating toolbar.

Ribbon
You can customize the Ribbon to
your liking. Right-click on any
tab to produce the shortcut menu
shown in Figure 1-33. You can
select which tabs and panels you
want to appear. For example, if you
want only certain panels to appear
for a specific tab, first click on the
tab, then use this menu to produce
a list of toggles for all the panels
that can appear for that tab, as
shown in the figure. If you choose
Undock from the shortcut menu the
Ribbon is converted to a palette.
You can drag the Ribbon palette to
the right or left side of the screen or
back to the top of the screen.

FIGURE 1-33
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FIGURE 1-34
You can further customize how much
of the panels appear in
the Ribbon. There is a
very small drop-down
arrow just to the right
of the last tab (Figure
1-34, top right). Use this
list to choose how you want the panels in each tab to appear. You can choose Minimize to Panel Titles to
increase space in the graphics area. With this option, only the panel titles appear without the tools (Fig.
1-34). To activate a panel and display the tools contained in the panel, momentarily rest the pointer on
the panel title until the full panel pops down to display the full set of tools (Fig. 1-34, top left).

Clean Screen

FIGURE 1-35

You can change the
AutoCAD window
from a normal window
to a window with no
toolbars or Ribbon (Fig.
1-35). Notice that the
Command line, Status
Bar, and pull-down
menus (if activated)
are still visible. This is
useful if you want to
maximize the drawing
area to view a drawing
Clean
or to make a presentaScreen
tion. Activate Clean
Screen by toggling the
small square in the
extreme lower-right
corner of the screen,
by toggling the Ctrl+0
(Ctrl and zero) key sequence, or by entering the Cleanscreenon and Cleanscreenoff commands.

Multiple Drawings
You can open multiple drawings at one
time in an AutoCAD
session (Fig. 1-36). You
will see the drawing
names on the File Tab.
You can click and drag
an open drawing from
the file tab to become
a floating window. To
restore it to the File
Tab, right click the file
header area to show the
menu and click Move to
File Tab.

FIGURE 1-36

Click and
drag
Right-click to show menu,
click Move to File Tab
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Options
Fonts, colors, and other features of
the AutoCAD drawing editor can
be customized to your liking by
using the Options command and
selecting the Display tab. Typing
Options or selecting Options…
from the Tools pull-down menu
or default shortcut menu activates
the dialog box shown in Figure
1-37. Selecting the Color… tile provides a dialog box for customizing
the screen colors.

FIGURE 1-37

NOTE: All changes made to the
Windows screen by any of the
options discussed in this section
are automatically saved for the
next drawing session. The changes
are saved as the current profile.
However, if you are working
in a school laboratory, it is possible that the computer systems
are set up to present the same
screen defaults each time you start
AutoCAD.

CHAPTER EXERCISES
1. Starting and Exiting AutoCAD
Start AutoCAD by double-clicking the “AutoCAD” shortcut icon or selecting “AutoCAD”
from the Start menu. Select Start Drawing in the opening AutoCAD screen. Draw a Line. Exit
AutoCAD by selecting the Exit Autodesk AutoCAD option from the Application Menu (“A” in
the upper-left corner). Answer No to the “Save changes to Drawing1.dwg?” prompt. Repeat these
steps until you are confident with the procedure.
2. Using Drawing Aids
Start AutoCAD. Turn on and off each of the following modes:
		Snap, Grid, Ortho, Polar Tracking
3. Understanding Coordinates
Use the Status Bar Customize button (lower-right corner) to turn on the display of Coordinates
and the Dynamic Input icon. Start the Line command. Begin drawing a Line by PICKing a
“Specify first point:”. Toggle Dynamic Input on and then toggle Coordinates to display the
Relative and Absolute formats (HINT: right-click on the coordinate display to access the format
options).
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PICK several other points at the “Specify next point or [Undo]:” prompt. Pay particular attention to the coordinate values displayed for each point and visualize the relationship between that
point and coordinate 0,0 (absolute Cartesian value) or the last point established and the distance
and angle (relative polar value). Finish the command by pressing Enter.
4. Using the Text Window
Use the Text Window (F2) to display the text window and the graphics screen.
5. Drawing with Drawing Aids
Draw four Lines using each Drawing Aid: Grid, Snap, Ortho, Polar Tracking. Toggle on and off
each of the drawing aids one at a time for each set of four Lines. Next, draw Lines using combinations of the Drawing Aids, particularly Grid + Snap and Grid + Snap + Polar Tracking.

